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Introduction
Stereology is a set of techniques for extracting 3D information from 2D images. Traditional 
stereological methods are referred to as model-based because they make the assumption that 
targets are spheres or ellipsoids. Because the mathematics behind model-based methods is 
complex, it is tempting to disregard these implicit assumptions and simply accept the 
methods as useful tools. Recently, however, a new set of stereological procedures has been 
developed. This “new stereology” differs from the traditional forms because it makes no 
assumptions regarding the shape of the objects to be measured. It is called unbiased 
stereology.
The optional Stereology module for MCID™ Basic uses the new, unbiased stereology. This 
document describes our stereological procedures for counting, sizing, and three dimensional 
(3D) surface measurements. 
The Stereology module has a dedicated user interface and set of tools that run within the 
MCID Basic environment. The user interface provides convenient selection of the factors 
that configure your system for stereology. To enable the Stereology module, select Settings 
> Study > Stereology or click the Stereology icon in the study type Shortcut Bar:

Available Measures
Most stereological measurements are ratios or densities. For example, we measure numerical 
density (Na, number of targets per unit area; Nv, number of targets per unit volume) or 
surface density (Sv, surface area of targets per unit volume). You can also use these core 
measurements to calculate other parameters. For example, you can derive the total number of 
targets, or the total surface area, or the average surface area per target.
If stereological measures are to be reported in relevant spatial units (e.g., mm3, µm2), the 
images must contain the appropriate spatial calibrations (e.g., Distance, Area, Section 
interval). See the online MCID Basic Reference Manual, Chapter 7: Calibrating Images for 
calibration instructions.
To select the kinds of measurements you wish to make, open the Sample menu and select the 
Measures selection option (Figure 1).
MCID Basic stereological measures are grouped into four categories: 2D Frames, 3D 
Probes, 3D Disectors, and 3D Fractionator. These measurements can be selected singly or in 
combination, allowing multiple stereological measurements to be carried out simultaneously. 
3D Disectors and/or 3D Fractionator measures, however, cannot be combined with any other 
measures.
03-MW-0167 Imaging Research Inc.



2  Stereology MCID Basic 7.0
Figure 1: The Measures Selection dialog box is used to select the kinds of stereological 
measures you wish to make.

2D Frames Measures
2D Frames measures are calculated from the 2D dimensions of a “sampling frame” and the 
target profiles contained within it. A sampling frame (Gunderson, 1977) is a rectangular tool, 
with two inclusive and two exclusive boundaries. A target is accepted only when it is 
completely inside the frame, or is touched by the inclusive boundary but not the exclusive 
boundary. In theory, the sampling frame gives any target an equal chance of being sampled, 
regardless of its 2D shape or size.

Ns: Number of 2D Targets
Number of target profiles contained within the sampling frame.

As: Area Sampled
Sampled area (area of the sampling frame). If a Distance or Area calibration is not in effect, 
As is the number of pixels contained in the counting frame.

Na: 2D Numerical Density
Number of target profiles per unit area. Na is calculated from the area of the sampling frame 
and the number of targets sampled in the frame. If a Distance or Area calibration is not in 
effect, Na is expressed as the number of target profiles per pixel.

Vv: Volume Ratio
Volume ratio (Equation 1) is also often called volume fraction. It is the ratio of target profile 
volume to sample volume.
Equation 1  Vv = est. [a / As]

Vv volume ratio
A sum of the area of all the target profiles in the sample
As area of the sampling frame 
Imaging Research Inc. 03-MW-0167



MCID Basic 7.0 Stereology  3
3D Probes Measures
3D Probes measures are calculated from a set of linear test probes oriented around points in a 
sampling grid. If data are to be expressed in spatial units, images must be calibrated to a 
reference scale.

Aa: Area Ratio
This is a simplified volume ratio measure, which divides the number of grid points 
overlaying a target by the total number of grid points measured.

Sv: Mean Surface Density
Surface area per unit volume (Equation 2). If a Distance calibration is not in effect, Sv is 
expressed as the number of targets per “voxel” (i.e., cubic pixel).
Equation 2 Sv = est. [2 (P / L) ]

Sv surface area per unit volume of the reference space
est. is estimated by
P total number of intersections between probes and profile boundaries
L total length of probes within the reference space

“Reference space” here is the total containing space. P can be automatically computed from 
the test probes. 

Vm: Mean Volume
Mean volume of sampled target profiles (Equation 3). If a Distance calibration is not in 
effect, Vm is expressed in “voxels”. 
Equation 3 Vm = mean [(pi/3) x (l3)] 

Vm mean volume
l intercept length - an intercept in a random direction in 3D through a random test 

point hitting a cell

3D Disectors
The “disector” was proposed as a direct estimator of the number of 3D objects, unbiased by 
their shape and size. It consists of two parallel sections, the reference section and the lookup 
section, separated by a known distance. On the reference section, target profiles are detected 
within a sampling frame (as described in 2D Frames Measures, above). To be accepted, 
targets must be absent from the lookup (i.e., previous) section. This condition results in the 
counting of cell tops. Use of the lookup section is critical, because the cells seen in the 
sampling frame are a biased sample in the height dimension. Bias results because the section 
hits cells with a non-uniform probability proportional to their height. Higher cells are more 
likely to be sampled than thinner ones. However, the subset of cells not hit by the look-up 
section is an unbiased, uniform sample (Sterio, 1984).
We use the term unbiased to mean that the probability of having a cell included in the subset 
is independent of the cell’s shape or size. We use the term uniform to mean that the lack of 
bias is present in all three spatial dimensions. 
03-MW-0167 Imaging Research Inc.



4  Stereology MCID Basic 7.0
3D Disectors measures are derived from aligned serial sections separated by a known 
distance. When the disector is applied to each section, it identifies new “target tops” seen 
within the sampling frame and computes both the number of 3D targets and the volume. 

NOTE: Since the first section in the series has no “lookup” section, no data is reported for 
the first image.

If data are to be expressed in spatial units, images must be calibrated to a Distance reference 
scale. A Section interval must also be specified in the Distance calibration.

N: Number of 3D Targets
Number of 3D targets contained in the sample, which are not present in the preceding (i.e., 
lookup) section.

Nv: Numerical Density of 3D Targets
Number of targets per unit volume (Equation 4). If a Distance calibration is not in effect, and 
if a Section interval is not specified, Nv is expressed as the number of targets per voxel.
Equation 4 Nv = N / Vs

Nv numerical density of 3D targets
N number of 3D targets counted 
Vs volume sampled (see Equation 5)

Vs: Volume Sampled
Volume sampled (Equation 5). If a Distance calibration is not in effect, and if a Section 
interval is not specified, Vs is expressed in “voxels”.
Equation 5 Vs = As x h

Vs volume sampled
As area of sampling frame
h section interval (distance between images)

You may be wondering about the difference between the volume sampled (Vs) and the 
volume of the reference space V(ref). Conceptually, these terms are different, though we 
simplified our discussion by equating the reference space and the space actually sampled by 
the disector(s). In this case, V(ref) is numerically equal to Vs, and N is equal to the sum of 
the “target tops” counted. However, we can set a general rule that we should use Equation 5 
when we deal with small, clearly demarcated volumes, that are well sampled by our 
disectors. This gives us the density of targets in our sampled volume. If our interest is to 
estimate the total number of targets in a much larger V(ref) than we can sample, Equation 6 
should be used. This gives us an extrapolated target number.
The estimate of the total number of 3D targets may be simplified as the following:
Equation 6 N = est. [Nv x V(ref)]

N total number of 3D targets
est. is estimated by
Nv numerical density of 3D targets
V(ref) volume of the reference space 
Imaging Research Inc. 03-MW-0167



MCID Basic 7.0 Stereology  5
The volume of the reference space V(ref) generally means a region of interest, such as the 
cerebral cortex.

3D Fractionator
3D Fractionator measures are a very direct and robust way of estimating a “total” number 
and the principles involved are very straightforward. Take a known fraction of the whole 
area/structure of interest, count every particle in that fraction and multiply by the fraction to 
arrive at an unbiased estimate of the “total”.
The MCID Basic automated optical fractionator integrates with a motorized XYZ stage and 
the Tiled Field Mapping (TFM) module to perform systematic random sampling over an 
entire region of interest. The user first specifies the number of sections to be counted, the 
section thickness, and the sampling frequency. A montage of each section is then created 
(with TFM) at low-magnification, and an area of interest is outlined on the montage. A 
higher magnification is then selected, and the stage automatically moves to random locations 
within the region of interest. At each location the user focuses up or down and uses the 
mouse to mark targets (i.e., cells) within the counting frame. The computer keeps track of the 
counts and calculates an estimate of the total number of targets based on the various fractions 
sampled.

NDet: Determined
This measure does not appear in the Measures Selection dialog box for the 3D fractionator. It 
is displayed as one of the columns next to the NEst - count and contains the actual number 
of targets counted in all the sampled fractions.

NEst: Estimated
This measure is an unbiased estimate of the total number of targets present within the area/
structure of interest. It is based on the total NDet value multiplied by the various fractions 
sampled.

Summary
Stereological measures are summarized in Table I, below. The table also indicates how each 
measure is estimated, how the specimen must be sectioned (see below), and which spatial 
calibration is necessary to express the data in appropriate units.

Table 1: Stereological measurements supported in MCID Basic

Measure Definition Method Name Section Type Calibration

Ns Number of 2D tar-
gets sampled

Unbiased sampling 
and counting frame

Vertical or IUR Not required

Na Numerical density Unbiased sampling 
and counting frame

Vertical or IUR Distance or Area

As Sampled 2D area Unbiased sampling 
and counting frame

Vertical or IUR Distance or Area

Vv Volume ratio Cavalieri’s principle Vertical or IUR Not required
03-MW-0167 Imaging Research Inc.



6  Stereology MCID Basic 7.0
Section Types
To ensure that stereological estimates are unbiased, tissue sections must be obtained in an 
appropriate fashion. This ensures that every part of the specimen has the same chance of 
being included in the sample, and that the sample is representative of the entire specimen.
Estimates based on disectors and/or fractionators (e.g., 3D target count, 3D target density) 
require Serial sections. All other estimates require Vertical or Isotropic Uniform Random 
(IUR) sections. Each of these section types has its own set of algorithms for generating test 
probes, ensuring that the probes are isotropic in 3D space.

Serial Sections
Stereological estimates that are calculated from disectors require serially adjacent sections, 
separated by a known distance and perfectly registered (aligned) with each other. The 
sections may be physical (i.e., physically cut) or optical (i.e., different focal planes through a 
thick specimen). The interval between the sections must be small enough so that no object of 
interest will escape detection between sections. The most effective interval between sections 
is about 30% of the smallest feature of interest.

Vertical Sections
A vertical section is a plane perpendicular to a given “horizontal” plane. No special meaning 
is attached to the “horizontal”, other than as a reference plane which defines the orientation 
of the sections. There are three ways to define the vertical direction (Baddeley et al. 1986): 

1. Find a naturally defined, intrinsic vertical direction in the specimen. In muscle 
tissue, for example, cylindrical fibers run roughly parallel to the macroscopic 

Aa Area ratio Point-sampled 
intercept

Vertical or IUR Not required

Sv 3D surface density Test probes Vertical or IUR Distance

Vm Mean target volume Point-sampled 
intercept

Vertical or IUR Distance

N Number of 3D tar-
gets

Disector Serial Not required

Nv Numerical density 
(3D)

Disector Serial Distance, section 
interval

Vs Volume sampled Disector Serial Distance, section 
interval

NDet Number of targets 
counted

Unbiased sampling 
and counting frame

Serial Distance

NEst Estimated total 
number of targets

Unbiased sampling 
and counting frame

Serial Distance

Table 1: Stereological measurements supported in MCID Basic

Measure Definition Method Name Section Type Calibration
Imaging Research Inc. 03-MW-0167



MCID Basic 7.0 Stereology  7
longitudinal orientation of the tissue. We could take vertical sections with 
reference to the fiber orientation, in either the longitudinal or the coronal planes.

2. A uniquely identifiable base plane is set as a horizontal reference plane, and the 
vertical direction would be defined to be normal to the horizontal. Many synthetic 
structures in material science and metallurgy, and flat tissues such as skin can be 
measured using this strategy.

3. Define the vertical direction artificially.
Generate vertical sections using the following rules:

1. All vertical sections must be normal to the pre-defined horizontal plane;
2. Vertical sections must have random positions, and random direction, which is 

normal to the horizontal plane. 

Isotropic Uniform Random (IUR) Sections
IUR sections are not used as frequently as vertical sections, because they are difficult to 
generate and must satisfy the following conditions:

1. There is no preference in selecting any particular orientation within the region of 
interest (isotropic selection). That is, the sectioning plane is randomly selected.

2. The location of the section is randomly selected from within the sample (uniform 
selection). There is no preference in selecting a section from any particular 
position.

In practice, IUR sections are usually generated according to a procedure called orientator. 
See Mattfeldt et al. (1985) for details.

Procedure: 2D Frames, 3D Probes and 3D Disectors
The Stereology module works in conjunction with the MCID Basic automatic target 
detection and measurement feature (Scan Area) for gathering 2D Frames, 3D Probes and 3D 
Disectors data. You first define a set of target criteria that distinguish features of interest (i.e., 
potential target profiles) from other image features, based on any combination of density, 
size, or shape. Once you have established an appropriate set of criteria, you use one of the 
Stereo Sample Tools (i.e., a 2D sampling frame) to define a region of interest. MCID Basic 
then searches the region for features that satisfy all of the detection criteria, generates the 
appropriate test probes, and reports the stereological data in the data table.
The basic procedure is as follows:

1. Load the images.
2. Make all necessary calibrations (e.g., Distance)
3. Select the measures you wish to make.
4. Establish detection criteria for target profiles.
5. Where required, adjust the sampling grid and specify the way in which the 

specimen was sectioned (e.g., Vertical or IUR)
6. Sample the images.
7. Edit the sampled images as required.
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8. Compile the results in the Stereology table.
This section describes how to use the MCID Basic Stereology functions and features to 
gather 2D Frames, 3D Probes and 3D Disectors data. At the end of this document is a 
Stereology Tutorial, which provides an explicit step-by-step guide through the sampling 
process.

The Stereo Sampling Grid
To calculate 3D Probes measures (Sv, mean surface volume; Vv, mean volume; Aa, area 
ratio), linear probes are oriented around regularly spaced points in a “sampling grid”. Before 
the specimen is sampled, the sampling grid should be adjusted so that no feature of interest 
contains more than a single grid point. The section type must also be specified, to ensure that 
the appropriate algorithms and test probes are used. For access to these settings, click on the 
Stereo Grid icon located in the Application toolbar:

A sampling grid appears over the image in the current channel. The Sampling Design dialog 
box also appears (Figure 2), as well as a set of Stereo Grid tools. The Sampling Design 
dialog box is used to specify a section type and sampling grid size. The Stereo Grid tools 
allow you to adjust the grid with the mouse.

Figure 2: The Sampling Design dialog box is used to specify a section type and sampling 
grid size.

Section Type

Specify whether sections are Vertical or IUR. Each of these section types has its own set of 
algorithms for generating test probes, ensuring that the probes are isotropic in 3D space.

Sampling Grid Options

The sampling grid should be adjusted so that no feature of interest contains more than one 
grid point. The size of the sampling grid is defined by the number of Rows and Columns and 
the Intervals between them. Values may be changed by typing new values into the 
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appropriate entry fields. Click on the [Refresh] button to update the grid after entering new 
values.
In theory, the position of the sampling grid should be systematically shifted by half of the 
grid point interval for every image in the stack to achieve better measurement precision. In 
practice, a fixed grid position will serve just as well. Either a Fixed grid position, or an 
(automated) Systematic shift of grid position may be selected.

Stereo Grid Tools

The size and position of the sampling grid may also be adjusted with Stereo Grid Tools:

Values in the Rows, Columns and Interval fields are automatically updated as the grid is 
adjusted.

 Shift

The Shift tool is used to select a new location for the sampling grid. Move the cross-hair 
cursor over any grid point. When the cross-hair turns into a pointing finger, drag the grid 
point to a new XY coordinate and release the mouse button. The entire grid is redrawn using 
these coordinates as a reference.

 Size

The Size tool is used to set a new grid point interval for the sampling grid. Move the cross-
hair cursor over any grid point and it becomes a pointing finger. Press the left mouse button 
and the grid point becomes one corner of a variable dimension box, defined by its three 
neighboring points. Drag the grid point to a new location and release the mouse button. The 
grid is redrawn using these coordinates as a reference. 

 Autoscan B

The Autoscan B tool automatically establishes an optimal grid point interval based on the 
size of the largest feature of interest. To use this tool, the target must be clearly distinct from 
the regions around it. Place the hollow arrow cursor on a background next to a target and 
click the left mouse button. When the cursor becomes a solid arrow, place it over the largest 
feature of interest and click again. The target outline is shown in red and its dimensions set 
the optimum grid size for this sample.

 Outline

The Outline tool establishes an optimal grid point interval based on the dimensions of a 
hand-drawn target. Hold down the left mouse button and trace around the border of the 
largest potential target. Release the mouse button and MCID Basic uses the feature’s 
dimensions to set the optimum grid size for this sample.
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 Pixel Info

The Pixel Info tool cursor is a cross hair with a single pixel in the middle. Position the cross 
hair anywhere on the image and click the left mouse button. The X Y coordinates and the 
density value for the pixel under the cross hair is displayed at the top left of the Image View. 
Use it to have a quick look at pixel density values.

Establishing Target Detection Criteria
The Stereology module works in conjunction with the MCID Basic automatic target 
detection and measurement feature, called “Scan Area” (see MCID Basic Reference Manual, 
Chapter 8: Automated Target Detection for complete details). You first define a set of target 
criteria that distinguish features of interest from other image features, based on any 
combination of density, size, or shape. Once you have established an appropriate set of 
criteria, you use one of the Stereo Sample Tools (see below) to define a region of interest. 
MCID Basic then searches the region for features that satisfy all of the target criteria, 
generates the appropriate test probes, and reports the stereological data in the data table.
Click on the Scan Area icon (located in the Application toolbar) to turn on the automatic 
target detection feature:

Selecting the Scan Area icon turns the automatic target detection feature on and off. 
Selecting the icon while pressing the <Ctrl> key calls up the Scan Area dialog box 
(Figure 3).

Figure 3: The Scan Area dialog box defines the segmentation range and has a variety of 
target detection options.
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The Scan Area dialog box is used to define target detection criteria. In the middle of the 
dialog box there is a set of slider controls for setting the upper and lower target density limits. 
Together, these limits are called a “Segmentation Range”. The Highlighting box is simply a 
visual aid to help establish the Segmentation Range. The Option Summary section displays 
the current status of optional features that can be modified by clicking on the [Options] 
button.

Setting a Segmentation Range

Density thresholds (light vs. dark) are the simplest criteria for target detection. You define a 
segmentation range using the upper and lower thresholds. Pixels having densities that fall 
within the segmentation range are regarded as valid targets. Pixels that are lighter or darker 
than the threshold values are ignored. In Figure 3, pixels lying between 0.2684 and 0.9031 
ROD are valid targets.
When adjusting the segmentation range, the goal is to set thresholds that distinguish targets 
from background. A very narrow segmentation range may yield pure targets, but genuine 
targets go undetected. By contrast, a wide segmentation range may include some background 
features as targets, or leave halos of background around each genuine target. It is much easier 
to set the correct threshold range if you have the Highlighting option set to Targets (see 
below).
The segmentation range can detect either dark or light targets. MCID Basic is equally 
capable of detecting dark targets against a light background or light targets against a dark 
background.

Highlighting

It is much easier to discriminate targets from background if they are shown in some easily 
perceived color. Select a target color from the Highlighting drop down list, then click on the 
Target radio button. Alternatively, you can color the background instead of the targets. To 
do this, select a color from the Highlighting list then click on the Background radio button. 
If you select None, neither target nor background are highlighted (this is the default 
condition).
While you are setting the segmentation range, you usually want to see targets filled with 
color. The color fill is removed when you work with the images. Color fill only re-appears 
when the automated scan detects targets. If you prefer to see target pixels colored at all times, 
click on the Keep highlight checkbox.

Processing the Image

Before establishing a density segmentation range, you may wish to perform a few image 
processing operations to make genuine targets stand out more clearly from background or 
modify the target structure. Image processing operations and filters are available through the 
Transform operation window (see MCID Basic Reference Manual, Chapter 13: Processing 
Images). Because image processing operations change image data you should limit pre-
processing only to the extent needed for setting an adequate segmentation range.
Various image processing features are available. In some instances, you could perform a 
series of Max or Min operations to establish more distinct boundaries between closely 
spaced targets and fill in holes within them. The Target Accentuate filter maximizes the 
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contrast between small image features and larger background regions (to apply the Target 
Accentuate filter, press <F12>). This filter reduces the contrast of all image components but 
more so for larger targets.

Establishing Spatial and Logical Criteria

A threshold operation rarely eliminates all the invalid targets from the scan. Usually, bits of 
background or other image features have density values similar to those of valid targets. In a 
scan based entirely upon density thresholds, these image characteristics may be confused 
with valid targets. To avoid this problem, MCID Basic lets you include additional spatial and 
logical target acceptance criteria. These target criteria include minimum and maximum area, 
minimum roundness, minimum and maximum chord, and other parameters.
You set spatial and logical criteria by clicking on the [Options] button in the Scan Area 
dialog box. This produces the Scan Area Options dialog box. Selecting Criteria on and then 
clicking on [Modify Criteria] calls up the Target Acceptance Criteria dialog box (Figure 4).

Figure 4: The Target Acceptance Criteria dialog box is used to define spatial and logical 
target criteria. 

The dialog box looks and works much like a calculator. To construct logical target criteria, 
use the number, symbol, and mathematical operation buttons in combination with the list of 
spatial measure categories on the right. 
Suppose you only wish to count image features that are between 100 and 200 µm2 in size. 
Open the Basic Morphometry group of measures to see the [Area] measure. Use the [Area] 
measure and the buttons to construct one line that says “[Area] > 100” and a second line that 
says “[Area] < 200” (double-click on the [Area] measure to add it to the statement). You can 
use any number of criteria. If targets are round, for example, you could also construct another 
line that says “[Form Factor] > .8”. (See MCID Basic Reference Manual, Chapter 5: 
Selecting Measures for more discussion on how to use these measures). 
When you are constructing logical criteria, you should use numerical values that correspond 
to your current spatial calibration units (see MCID Basic Reference Manual, Chapter 7: 
Calibrating Images). If your image is not calibrated, spatial unit values are expressed in 
pixels.
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When Target Criteria are not Adequate

If it is not possible to establish detection criteria that adequately distinguish features of 
interest from background, then each feature of interest must be manually defined when you 
sample the image. See Manual Target Definition, below.

Stereo Sample Tools
Stereo Sample Tools are used in conjunction with the MCID Basic automatic target 
detection feature (Scan Area) to define regions of interest and derive stereological measures 
from the objects (target profiles) found within them:

The basic sample tool is the “sampling frame” or “counting frame” (Figure 5), a rectangular 
box with broken lines for its upper and right boundaries (inclusion lines) and solid lines for 
its left and lower boundaries (exclusion lines). The sampling frame counts targets that fall 
completely within its boundaries plus any target, which touches the inclusion lines. Targets 
that touch the exclusion lines are not counted. 
Two sampling frames are available, one that can be dragged to any size and moved about, 
and one that remains in a fixed position.

 Continuous Frame

The Continuous Frame can be positioned anywhere within the image. To adjust the size of 
the frame, move the mouse while holding down the <Ctrl> key. Click the left button to 
sample.

 Channel Frame

The Channel Frame can be locked into a fixed position within a channel. To adjust the 
initial size of the frame, move the mouse while holding down the <Ctrl> key. To position the 
frame, move the mouse while holding down the <Shift> key.

Figure 5: The 2D sampling and counting frame.
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Defining Outer Scan Areas

Recall that the sampling frame counts and samples any target that touches its inclusion lines, 
even if the target extends beyond the frame. MCID Basic must consequently scan a region 
outside of the frame, adjacent to the inclusion lines. To specify the amount of adjacent image 
area to scan, double-click on one of the frame tool icons. This will display the Stereology 
Frame Cursor Settings dialog box (Figure 6).

Figure 6: The Frame Cursor Settings dialog box is used to define the amount of adjacent 
image area to scan, and to enable automatic sampling across an entire image set.

If you select the Use frame with margin option, MCID Basic scans the area within the 
counting frame plus a small region adjacent to the inclusion lines. The adjacent region 
extends to about one third of the length and width of the sampling frame. If you select the 
Use full image option, MCID Basic scans the entire image area adjacent to the inclusion 
lines. This option may tax system memory if you are working with very large (e.g., tiled) 
images.

Labeling Data
MCID Basic tracks stereological data using the following labeling scheme:

SubjectAnimal/Subject used in study.
SectionTissue section obtained from subject (image filename or channel number).
RegionAnatomical area.
TargetArea of image sampled with a single sampling frame.

Subject, Section and Region labels are located at the top of the Sample operation window. 
Before gathering data, click on the Subject and Region headings and enter the appropriate 
labels. The default label is “?”.
MCID Basic automatically creates Section labels as each image is sampled. If you are 
working with image files, MCID Basic will use their filenames as labels. If images are 
digitized into consecutive channels, MCID Basic will use channel numbers for Section 
labels.

Collecting Data
To gather data, select one of the sampling frame tools and position it over the image. The 
general rule is to size the frame to select as many target profiles as possible, while making 
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sure that the broken sides of the frame (inclusion lines) avoid targets that intersect the edges 
of the image.
Press the left mouse button to sample the image. MCID Basic first scans the sampling frame 
(and the region adjacent to the inclusion lines) for targets that fall within the segmentation 
range. If you have established spatial criteria, MCID Basic scans the frame a second time 
and searches for targets that also fulfill these additional criteria. As the scan proceeds, MCID 
Basic displays “valid” targets (i.e., those that meet the spatial criteria as well as the density 
criteria) in one overlay color and “excluded” targets (i.e., those that meet the density criteria 
but not the spatial criteria) in another. Stereological measures are derived from “valid” 
targets and reported in the data table.
Repeat the sampling procedure for all other images in the series, or use auto-sampling feature 
(described below) to sample the entire image set in one operation. If you are working with 
3D Disectors (i.e., with aligned serial sections), be sure to sample the same 2D coordinates in 
each image. Use the Channel frame tool or the auto-sampling feature to keep the same 
coordinates across all sections.

Automatic Sampling Across an Image Set
You can analyze your specimens one section at a time, or as a stack containing any number 
of sections. Use the Image > Image set > Retrieve command to load multiple image files into 
consecutive channels or into an image file storage list (see MCID Basic Reference Manual, 
Chapter 6: Making and Loading Image Files for complete details). You can then perform an 
automated analysis across the entire stack with a single operation.
To enable auto-sampling mode, double-click on whichever counting frame tool you will use 
to gather data (i.e., Continuous frame or Channel frame). When the Frame Cursor Settings 
dialog box appears (Figure 6), turn on the Auto sampling on sections option.
When you are ready to sample the images, click the counting frame in the first image in the 
series. When the Auto Sampling On Sections dialog box appears (Figure 7), specify the range 
of images to sample.

Figure 7: The Auto Sampling On Sections dialog box. If images are loaded into consecutive 
channels, specify the range of channels to sample. If images files are loaded into a storage 
list, the filenames of the first and last images are displayed.

Click the [Sample] button to begin sampling the image set. MCID Basic generates the 
appropriate test probes, scans each image for targets that meet the detection criteria, and 
reports the results in the data table.
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Displaying Data
Measurement results are displayed in the Sample window in both tabular and graphical 
forms.

Figure 8: Tabular data display.

Data Tables

The Table toolbar (View > Table bar) provides two data tables for displaying stereological 
data:

The default data table is the Target table (Figure 10). It displays data from individual 
sampling frames for the specified Subject, Section and Region label. Use this table to gather 
and edit data.
The Stereology table summarizes data gathered from all counting frames across all sections 
(images). MCID Basic computes and displays the appropriate summary value for each 
measure and summarizes the appropriate stereological parameters upon which the measure is 
based (e.g., # frames, # intercepts). Data may be sorted by Subject and/or Region label.
Please note, although summary statistics (Mean, SD) are displayed at the bottom of the 
Target table, these values should not be used to express final results. In order to generate 
measures that are representative of the entire specimen, we must pool data obtained from 
individual samples (i.e., across all sections). Always use the Stereology table for reporting 
final results.

Levels of Data Display

Within each summary table, data may be sorted across or within Subject, Section and/or 
Region labels. Click on the  button (next to the Subject heading) to select different 
combinations of Subject, Section and Region display modes.
Current regionDisplays data gathered under the currently selected Region label (default 

Region display mode). Click on the Region heading to select another 
label.

All regionsDisplays data gathered under all Region labels. Data are labeled with individual 
Region names.

Current sectionDisplays data gathered under the currently selected Section label.
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All sectionsDisplays data gathered from all Section labels (default Section display mode). In 
the Target table, data are labeled with individual Section names (i.e., 
image filename or channel number).

Current subjectDisplays data gathered under the currently selected Subject label (default 
Subject display mode).

All subjectsDisplays data from all Subject labels. Data are labeled with individual Subject 
names.

Graphical Data Display

The graph area in the Sample window displays the incremental calculation of any measure in 
the data table, over all sampled sections. Figure 9, for example, shows the estimation of mean 
surface density (Sv) plotted against the number of test probes used.

Figure 9: Graphical display of mean surface density (Sv), plotted against the number of 
probes.

The graphical display is an effective way to monitor the reliability of particular measures 
(e.g., Sv) as sampling progresses. If the estimated measure is fairly stable (as in Figure 9, 
above), it is an indication that enough measurements have been made to reach a reliable 
result. Further measurement is probably unnecessary. In contrast, if the graph shows variable 
measurements, this indicates that more data should be taken.
Select which measure to plot by clicking on its column heading in the data table. When a 
different measure is selected from the data table, the graph is redrawn and the axis labels are 
updated. The following shows what MCID Basic plots for each of the measures:

Ns – Number of 2D targets sampled, plotted against the number of counting frames 
used.
As – Area sampled, plotted against the number of counting frames used.
Na – 2D target density, plotted against the number of counting frames used.
Aa – Area ratio, plotted against the number of intercepts used.
Vv – Estimated volume ratio, plotted against the number of counting frames used.
Sv – Mean surface density, plotted against the number of probes used.
Vm – Mean target volume, plotted against the number of intercepts used.
N – 3D target count, plotted against the number of disectors used.
Vs – Volume sampled, plotted against the number of disectors used.
Nv – 3D number density, plotted against the number of disectors used.
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Editing Data
Automated measurements depend upon an accurate discrimination between target and 
background. Making this discrimination (usually on the basis of a density threshold) is 
known as segmentation. Automated segmentation works very well with clearly stained or 
labeled targets, but can be more difficult with many less clearly demarcated specimens. 
Therefore, some post-sampling editing of data may be necessary.
There are two ways to edit stereological measures. One way is to add or delete targets in the 
sampled image(s). The other way is to edit the stereological probes upon which particular 
measures are based. For example, we can edit Vm by adding an intercept at any sampling 
grid point, deleting any intercept, or by modifying the length of any intercept.
To add or delete targets in a sampled image, press <F8> or select the Stereo editing tools 
option from the Edit menu. Select Scan windows editing as the editing mode (Figure 13). 
Use any of the available Scan Editing tools to add or delete targets in the current image. 
Data are updated accordingly. Click [Done] to exit data editing mode.

Figure 10: MCID Basic provides two editing modes for stereological data. Select “Scan 
windows editing” to add or delete targets in sampled images. Select “Stereology editing” to 
edit the probes upon which a measure is based.

To edit specific stereological probes, first select the measure you wish to edit by clicking on 
its column heading in the data table. Press <F8> (or select the Stereo editing tools option 
from the Edit menu) and select Stereology editing as the editing mode. Use the appropriate 
Stereo Editing Tool to edit the probes that appear over the sampled image. Data is updated 
accordingly as each probe is edited. Press [Done] when all images have been edited as 
necessary. 

Scan Edit Tools

The Scan Edit toolbox/toolbar contains tools for adding and deleting targets in scanned 
images:

They are also used to manually define target profiles when it is not possible to use the MCID 
Basic automatic target detection feature.

Deleting Targets
Select the Delete tool to delete a target profile (filled with red overlay) from the scan area. 
When you click the Delete tool on any sampled target profile, the overlay color disappears 
and data are updated accordingly.
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Adding Targets
The remaining Scan Edit tools operate just like standard Sample tools. For example, select 
the Outline tool to manually trace around the border of an undetected feature of interest. 
Click inside the outline and MCID Basic adds the feature to the sample. Data are updated 
accordingly. 

NOTE: MCID Basic will only derive data from feature(s) of interest, which lie 
completely within the boundaries of the sampling frame or touch an inclusion 
line.

Stereo Editing Tools

Stereo Editing Tools are used to edit the test probes used to estimate particular stereological 
measures:

Note that specific tools are not available until an associated measure (Sv, Vm, N, or Nv) is 
selected in the data table.

 Surface probe

The Surface probe tool is used to edit the mean surface density measure (Sv), by adding or 
deleting intersections between test probes and target profile boundaries. On the sampled 
image, intersections are shown as small green circles. To delete an intersection point, click 
on it with the right mouse button. Click the left mouse button to add a new intersection point.

 Volume probe

The Volume probe is used to edit the mean target volume measure (Vm) measure. It is 
useful if segmentation is unreliable and you need to manipulate the lengths of the intercepts 
accurately. Click the cursor on any sampling grid point (displayed in green on the sampled 
image) and MCID Basic creates a linear probe oriented around the point. To extend the 
probe, place the cursor on one end of the probe and drag it outward. The probe extends to the 
point where you release the mouse button. To shorten the probe, click the right mouse button 
on the point where you wish the probe to end. To delete a probe, hold down the <Ctrl> key 
and click on the probe with the right mouse button.

 Area probe

The Area probe tool is used to edit the area ratio measure (Aa), by adding or deleting 
intersections between test probes and targets. On the sampled image, intersections are shown 
as small yellow circles, which appear over grid crosses. To delete an intersection point, click 
on it with the right mouse button. Click the left mouse button to add a new intersection point 
over a grid cross.

 Profile pointer

The Profile pointer is used to edit 3D target count (N) or 3D target density (Nv) measures. 
On sampled images (other than the first image), 2D target profiles are displayed in the 
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current cursor color. Profiles that were not present in the preceding section (i.e., the tops of 
new 3D targets) are outlined in another color. To unmark a 3D target, click on it with the 
right mouse button. It is then treated as a 2D target profile. To designate a 2D target profile 
as a 3D target, click on it with the left mouse button.

 Pixel Info

The Pixel Info tool cursor is a cross hair with a single pixel in the middle. Position the cross 
hair anywhere on the image and click the left mouse button. The XY location and the density 
value for the pixel under the cross hair is displayed at the top left of the Image View. Use it 
to have a quick look at densities without actually taking data samples.
You can set the Pixel Info tool to express pixel location and density in various units. Click 
on the Pixel Info icon while pressing the <Ctrl> key to define the location and the density 
units.

Manual Target Definition
If it is impossible to establish an automatic target detection criteria that adequately 
discriminates between features of interest and other image features (i.e., if it is not possible to 
use the MCID Basic automated target detection feature at all), then each feature of interest 
must be manually defined.
If the Scan Area feature is not turned on when you sample an image, MCID Basic will 
automatically enter the data editing mode and display the Scan Edit toolbar:

Use any of the available tools to define all target profiles that fall completely within the 
boundaries of the counting frame, and all targets, which touch the inclusion boundaries. Data 
from the sample are updated each time a target profile is defined.

Procedure: 3D Fractionator
When stereology is used with an MCID Basic system it is able to integrate microscope stage 
control and implement an automated optical fractionator for cell counting procedures. Taking 
advantage of the optical fractionator requires that the MCID Basic system be equipped with 
a motorized XYZ microscope stage (preferably with a linear encoder on the Z-axis control). 
Below are listed the additional measures available with the automated optical fractionator 
within stereology.

Table 2: Optical Fractionator Measures

Parameter Definition Method Name

NEst Estimated total number of targets Unbiased sampling and counting frame

NDet Number of targets counted Unbiased sampling and counting frame
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When using the automated optical fractionator method, the user predefines the number of 
sections to be counted (from the total sections available), the section thickness, and the 
sampling frequency. A montage of each section is created at low power, and an area of 
interest is outlined on this montage. A higher power is selected, and the system uses random 
systematic sampling to move to the first location within the region of interest. Subsequent 
locations are located by moving the motorized stage in a systematic pattern over a grid of the 
area of interest. The precise fraction sampled relative to the area between locations is thus 
known. At each location, interactive sampling is performed. 
To count targets, the user focuses up and down and marks targets within the counting frame. 
An on screen indicator displays the current Z position and guard volume locations. The 
computer keeps track of the counts and calculates an estimate of the total number of targets 
based on the various fractions sampled.

Setting up the Automated Optical Fractionator
Before entering the Stereology study type and selecting the automated optical fractionator, 
one should be familiar with the configuring and setting up of a motorized stage. This 
familiarity should also include the stage alignment procedure, objective calibrations and the 
creation of a nosepiece file. One should also be familiar with the procedure of tiled field 
mapping (TFM). These topics are explained in detail in the motorized microscope stages and 
TFM sections of the online MCID Basic Reference Manual.
Go to the Stereology study type and from the Sample menu option choose Measures 
selection. This will display the Measures Selection dialog box (Figure 11), listing all the 
available stereology measures. Open up the Stereo: 3D fractionator group of measures and 
select the NEst (Estimated) measure.

Figure 11: The Measures Selection dialog box, used for choosing types of stereological 
measures.
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Once you have made your measurement selection, close the Measures Selection dialog box 
and go back to the Sample menu option and select Wizard:

This Wizard option in the Sample menu only appears once you have selected the NEst 
measure from within the Stereo: 3D fractionators and allows you to proceed with the 
automated optical fractionator setup. By selecting Wizard you will be guided via a series of 
dialog boxes, prompting you for various experimental parameters.

The Optical Fractionator Wizard

Figure 12: The first in a series of the Fractionator Wizard dialog boxes. This one deals with 
selecting the low power objective.

In the first Fractionator wizard option (Figure 12) you will be asked to select the objective 
that you plan to use for defining the region of interest at low power. This objective can be 
selected from a predefined list created during the nosepiece definition procedure. If the 
objective does not appear on this list, you will have to exit the Stereology study type, go into 
the microscope calibration setup and add the appropriate objective to the nosepiece list. 
Pressing the [Next] button will move you to the next step in the wizard (Figure 13).
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Figure 13: Selecting the cell counting objective.

You will now be asked to select the objective you plan to use for counting. This is the end of 
the objective definition and pressing the [Next] button will take you to the experimental 
parameters definitions (Figure 14).

Figure 14: Defining the experimental parameters within the fractionator wizard.

In the Setting up experiment parameters section you are asked to describe your 
experimental protocol. The total number of cut sections, the number of sections you wish to 
sample and the actual section thickness, are all required. For example, if you have cut 50 
sections through your structure of interest then the answer to the total number of sections 
should be 50. Of those 50 sections you may wish to sample every tenth section so the number 
of sections to sample should be entered as 5. The actual, measured thickness of the section 
should be entered and not the thickness the sections may have been cut at. 
In the above example we are going to sample 3 sections out of a total of 10, with a measured 
section thickness of 35 µm. Press [Next] once all the parameters have been entered.
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Figure 15: Defining the guard volume in the section.

The next input required is the Guard volume. This defines the region above and below the 
counting volume. The guard volume prevents counting errors that maybe associated with 
artifacts found on the surface of the cut planes of your sections. In this example we will 
define a guard volume of 5 µm. Press [Next] to proceed. 

Figure 16: Setting up the counting frame.

After defining the Guard volume the Fractionator wizard moves on to allow you to define 
the size of the counting frame. Initially the counting frame volume is set to 0.003 mm3. Move 
the cursor over to the Image View window. The cursor changes to the counting frame cursor 
with the red solid lines denoting exclusion zones and the green broken lines denoting 
inclusion zones. To adjust the size of the counting frame, press and hold the <Ctrl> key 
while moving the mouse. Once you are satisfied with the size and position of the counting 
frame, click on the left mouse button to sample the frame. The Fractionator wizard will now 
update the counting frame volume. Click on the [Next] button to move to the next stage in 
the Fractionator wizard.
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Figure 17: Getting ready to perform the tiling operation.

You are now asked to select the low power objective and place the appropriate slide under 
the microscope. In the above example you are asked to place the slide containing section #2 
under the microscope. Section #2 has been chosen random systematically from the 
information provided when defining the experimental parameters (Figure 14). Once you have 
completed these steps press the [Next] button to continue with the Fractionator wizard. You 
will now be placed into the tiling module part of the system (Figure 18).

Figure 18: Within the Tiling module component of the Optical Fractionator Wizard.

At this point in the proceedings the object of the exercise is to create a tiled image of the area 
of interest within which, you wish to count targets under high power. You should be familiar 
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with the operation of the tiling module and detailed instructions can be found in the online 
MCID Basic Reference Manual, Chapter 17: Tiled Field Mapping. Once you have completed 
the tiled image, it will appear in the Image View window.

Figure 19: An outline of the region of interest from the tiled image under low power.

You will be asked to select one of the available Stereo outline tools and trace out the region 
of interest from the tiled image. Sampling this outline will display it within the Fractionator 
wizard dialog box. Click on the [Next] button, once you have defined the outline of your 
region of interest.

Figure 20: Selecting the sampling frequency.

This dialog box displays the total area in calibrated units, of your outlined region of interest. 
Type a number in the sampling frequency box and a series of small boxes will be displayed 
over the outline of your defined region of interest. These boxes denote the number and the 
locations of the counting frames that are to be sampled. The higher the sampling frequency 
the more sampling points will be displayed. The object here is to set the sampling frequency 
to a value that will give you a total of between 100 to 200 actual targets counted within the 
whole experiment, over multiple sections/slides. In this example we have selected a value of 
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2%, which happens to correspond to 3 locations to be sampled under high power for this 
region.

Figure 21: Getting ready for target counting under high power.

Clicking on the [Next] button will move you to the next Fractionator wizard window where 
you will be asked to select the cell counting objective. In this example (Figure 21), you are 
asked to select the 40X as the cell counting objective. Clicking on the [Next] button will 
move you to the next Fractionator wizard dialog box (Figure 22).

Figure 22: Adjusting the focus under the high power counting objective.

You are now asked to adjust the focus so that the top of the section is just coming into focus. 
At this point you have the option of checking the Skip manual focusing checkbox. Placing a 
checkmark will cause the system to assume that the first time you adjust the focus for the top 
of the section, it will now be correct for all subsequent locations within the selected outline. 
Once you are happy with the focus, press the [Next] button. The system will automatically 
move down through the sample the distance you have previously specified as the guard 
volume, in this case 5 µm, see Figure 15 Once the guard volume distance has been adjusted 
for, the next dialog box appears (Figure 23).
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Figure 23: The target counting dialog box. The box outlined in green denotes the current 
high power location within the outlined region of interest on the first section.

The automated optical fractionator wizard has positioned the section at the first location and 
placed the counting frame at the top of the section, just below the 5 µm guard volume. You 
are now ready to begin counting. On the image monitor you will see the counting frame 
outline and the green bar on the above dialog box denotes the depth of the counting frame. 
The red bars, above and below the green bar, represent the guard volume. The black line 
marks your actual Z position within the slice. As you move the focus knob this black line will 
also move to let you know where you are located within the section. Adjust the focus knob 
and as a target comes into focus on the image monitor, use one of the Manual Target 
Finding tools to mark the target on the image display:

If you try and mark a target when the black line is in the red zone or part of the target is over 
the red solid lines in you counting frame, a beep will sound and the target will not be marked. 
Once you have marked all the targets, press [Next] to continue.
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Figure 24: The fractionator wizard for adjusting the focus under the high power, for the next 
location. The blue box denotes the last location visited and the next location is now outlined 
in green.

Once again you are now asked to adjust the focus for the new position so that the top of the 
section is just coming into focus. Once you are happy with the focus, press the [Next] button. 
Again, the system will automatically move down through the sample the distance you have 
previously setup as the guard volume, see Figure 15. Once the guard volume distance has 
been adjusted for, the next dialog box appears (Figure 25).

Figure 25: The target counting dialog box. The blue box denotes the previously sampled 
location and the box outlined in green denotes the new current location.

You are now ready to continue counting. Adjust the focus knob and as a target comes into 
focus in the Image View, use one of the Manual Target Finding tools to mark it. Once you 
have marked all the targets press [Next] to continue. 
If this is the last location for the first section you will be asked to switch to the low power 
objective and place the next section under the microscope (Figure 26).
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Figure 26: The Fractionator, Preparing for Tiling dialog box.

Pressing [Next] will proceed you through the tiling procedure for the second section. In this 
example you will once again be asked to outline the region of interest, then switch to the high 
power objective and be moved to the first location in section #2 and asked to adjust the focus 
for the top of that section etc. Once you have repeated the target counts for locations in 
section 2 the same procedure would be repeated for the final section (remember that in the 
original sequence we chose to sample three sections from a total of ten experimental 
sections). When the sampling has been finished the various fraction results will be displayed 
in the final dialog box (Figure 27).

Figure 27: The Fractionator Results dialog box showing the various fractions measured.

Pressing the [Finish] button exits the Fractionator wizard. Data are now displayed in the 
Sample operation window.
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Stereology Tutorial
The following is a step-by-step guide through the 2D Frames, 3D Probes and 3D Disectors 
data acquisition process. The optical fractionator is not included in this tutorial, as there is 
already a Fractionator Wizard to guide you through the 3D Fractionator data acquisition 
process.
Before proceeding with this tutorial, you should know how to carry out the following 
procedures:

• retrieve and display a set of images 
• work with multiple images
• use automatic target detection 
• select various measures 
• gather data from an image

If you are unfamiliar with any of these operations, please consult the appropriate tutorial 
lesson in MCID Basic Tutorials, and the appropriate sections in the online MCID Basic 
Reference Manual.
The tutorial uses a set of image files contained in the Stereology Tutorial Data.  The 
Tutorial dataset is included on the MCID Basic installation CD-ROM. If you have not 
installed the Tutorial Data, please do so now. Select the Custom installation option and 
install the Stereology Tutorial Data component. See the “Software Installation” section in 
the MCID Basic Start-Up Guide for complete instructions.
In the Stereology study type, many stereological parameters (e.g., sampling frames, test 
probes, intersection points, etc.) are superimposed over images in a variety of different 
overlay colors. The actual colors in which these features are displayed is determined by the 
current cursor color. In this tutorial lesson, we refer to particular features by the color they 
appear when the cursor color is set to red. Before beginning the tutorial, set the cursor color 
to red. Adhering to this overlay color scheme will help you easily identify particular 
stereological parameters when they are described in the tutorial.

TO SET THE CURSOR COLOR:
1. Move the cursor to the image monitor.
2. Press <F3> until the cursor turns red.

Selecting the Stereology Study Type
TO SELECT THE STEREOLOGY STUDY TYPE:
1. Select Settings > Study > Stereology, or
2. Click the Stereology icon in the study type Shortcut Bar:
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Procedure: 2D Frames and 3D Probes
This section describes the procedures used to derive 2D Frames and 3D Probes measures. 
The procedure for deriving 3D Disector measures is slightly different, and requires a 
different set of sections. For these reasons, the 3D Disector method is described in a separate 
section.

Displaying the Tutorial Images

TO LOAD IMAGES:
1. Open the Settings menu and select the Display format option. The Display Format 

dialog box appears on the screen (Figure 28).
2. Set the Image Type to “8 bits”.
3. Select “4” as the total number of channels and “1” as the total number of views.
4. Click [OK] to exit the dialog box.

Figure 28: The Display Format dialog box.

5. Open the Image menu and select Image set > Retrieve.
6. When the Retrieve Image Set dialog box appears (Figure 29), Press the [Add] 

button to specify which image files to load.
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Figure 29: The Retrieve Image Set dialog box is used to load a set of image files in a single 
operation.

7. The Select Files dialog box will now appear (Figure 30). Navigate to the directory 
where the sample images are stored (the default directory is \MCID Basic 
7.0\IMG) and retrieve the images SV1.IM - SV4.IM. To select a file, first click on 
it then click on the [Add] button. The selected file appears in the list of Images to 
load section of Figure 37. There are two ways to select more than one file at a 
time: 

i)hold down the <Ctrl> key while clicking on the filenames.
ii)hold down the <Shift> key while clicking on the first file in a consecutive 

list and then clicking on the last file.

Figure 30: The Select Files dialog box is used to select the files that comprise the image set.

8. Press [Done] to return to the Retrieve Image Set dialog box.
9. Specify retrieval options (overlay, calibrations, rotation) and [Sort] the images if 

necessary.
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10. Turn on the Channels radio button and enter a Starting channel number as 
channel 1.

11. Click [OK] to load the images into consecutive channels. Images load in the order 
that they appear in the list.

12. The images are now displayed in Channels 1 - 4.

Selecting Measures

Stereological measures are grouped into four categories: 2D Frames, 3D Probes, 3D 
Disectors and 3D Fractionators. These measurements can be selected singly or in 
combination, allowing multiple stereological measurements to be carried out simultaneously. 
Because of the different ways in which specimens must be sectioned, however, 3D Disectors 
and/or 3D Fractionator measures cannot be combined with 2D Frames or 3D Probes 
measures.
 When you select Stereology as your study type, the data table initially contains 3D 
Disectors measures (N, Vs, Nv).

TO SELECT ADDITIONAL MEASURES:
1. Open the Sample menu and select Measures selection.
2. The Measures Selection dialog box appears on the screen (Figure 31).

Figure 31: The Measures Selection dialog box is used to select different stereological 
measures.

3. From the Available Measures list, open the Stereo:2D frames and Stereo:3D 
probes categories by clicking on the “+” button. Add every measure in these two 
categories to the list of Selected Measures.

4. Click [OK] to proceed. The selected measures appear as separate columns in the 
data table.

Stereo Grid Definition

To calculate 3D Probes measures (Sv, mean surface volume; Vv, mean volume), linear 
probes are oriented around regularly spaced points in a “sampling grid.” Before the specimen 
is sampled, the sampling grid should be adjusted to the appropriate size. The section type 
must also be specified, to ensure that the appropriate algorithms and test probes are used.
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ADJUSTING THE SAMPLING GRID:
1. Click on the Stereo Grid icon (in the Application toolbar) to access the sampling 

grid options:

2. A sampling grid appears over the image in the current channel. The Sampling 
Design dialog box also appears (Figure 32), as well as a set of Stereo Grid Tools:

The Sampling Design dialog box is used to specify a section type and sampling grid size. The 
Stereo Grid Tools allow you to adjust the grid with the mouse.

Figure 32: The Sampling Design dialog box is used to specify a section type and sampling 
grid size.

3. Under the Section Type heading select Vertical. This establishes an appropriate 
set of algorithms and test probes that will be used to derive the 3D Probes 
measures.

4. To adjust the size of the sampling grid, select the Size tool from the toolbox:

5. Position the cursor over the image in Channel 1. Move the cross-hair cursor over 
any grid point and it becomes a pointing finger. Press the left mouse button and 
the grid point becomes one corner of a variable dimension box, defined by its 
three neighboring points. Drag the grid point to a new location and release the 
mouse button. The grid is redrawn using these coordinates as a reference. Note 
that the grid dimensions are updated in the Sampling Design dialog box.

6. The grid size should be chosen with reference to the size of the features of 
interest. The basic goal is to adjust the grid size so that none of the features of 
interest contain more than one grid point (as in Figure 33, below). Scroll through 
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all of the images in the set to find the largest feature of interest. Use this feature as 
a reference when sizing the grid (i.e., adjust the grid size so that the feature 
contains only one grid point).

Figure 33: The size of the sampling grid should be adjusted so that no feature of interest 
contains more than one grid point.

7. The simplest way to establish the appropriate grid size is to use the Outline or 
Autoscan B tool to define a feature of interest. MCID Basic then uses the 
feature’s dimensions to set the grid size. For example, select the Outline tool 
from the Stereo Grid Tool toolbar:

8. Trace around one of the smaller target profiles with the left mouse button. When 
you release the mouse button, MCID Basic adjusts the grid interval so that it 
matches the dimensions of the target profile. However, note that larger target 
profiles contain more than one grid point. Thus, the grid is too small for this 
sample. For proper grid adjustment, trace around the largest feature of interest.

9. The Autoscan B tool may be used in lieu of the Outline tool:

Place the hollow arrow cursor on a background region next to a target profile and 
click the left mouse button. When the cursor becomes a solid arrow, place it over 
a profile and click again. The target outline is shown in red and its dimensions 
establish the grid size for this sample. To establish an optimal grid size, use the 
tool to define the largest feature of interest in the sample. This should yield 
approximately 18 rows of points with an interval of about 36 µm.

10. Return to the Stereo Grid Tool box and select the Shift icon:
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11. Position the cursor over the image in Channel 1. Move the cross-hair cursor over 
any grid point. When the cross-hair turns into a pointing finger, drag the grid 
point to a new XY coordinate and release the mouse button. When you release the 
mouse button, the grid will align itself to a new position.

12. The position of the sampling grid should be random with reference to the image. 
The Shift icon lets you randomize grid positions.

13. Return to the Sampling Design dialog box and click [OK] to proceed.
TO ESTABLISH DETECTION CRITERIA:
1. Click on the Scan Area icon (in the Application toolbar) to turn on the MCID 

Basic automatic target detection and measurement mode:

2. The Scan Area dialog box appears (Figure 34). The Scan Area dialog box is used 
to define target detection criteria. In the middle of the dialog box there is a set of 
slider controls for setting the upper and lower target density limits. Together, 
these limits are called a Segmentation Range. The Highlighting option is simply 
a visual aid to help establish the Segmentation Range.

Figure 34: The Scan Area dialog box is used to define criteria used for automatic target 
detection and measurement.

3. Set the Highlighting option to Target and set the highlight color to Red.
4. To set the density criteria, place the cursor in either of the two flags on the right 

side of the controls and drag them up or down. The upper flag controls the 
brightness limit and the lower flag controls the dark limit. The gray level value of 
each threshold is displayed in the flag as you drag it. Objects that fall within the 
range of the upper and lower density limits are filled in red (highlighted).   The 
goal is to adjust the density criteria so that the features of interest are red.
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5. Move the upper flag to show about 246 Levels and the lower one to about 20 
Levels. With these criteria, all of the target profiles in the sample images are 
highlighted in red.

6. Click [OK] to exit.

Gathering Data

Images are sampled with a tool called a “sampling frame” or “counting frame”, a rectangular 
box with broken lines for its upper and right boundaries (inclusion lines) and solid lines for 
its left and lower boundaries (exclusion lines). Data are derived from target profiles that fall 
completely within its boundaries plus any target, which touches the inclusion lines. Targets 
that touch the exclusion lines are not included in the sample.

TO START GATHERING DATA:
1. Select the Continuous frame tool from the Stereo Sample toolbox/toolbar:

2. Move the cursor to the image in Channel 1. The goal is to size the sampling frame 
to select as many target profiles as possible, while making sure that the broken 
sides of the frame (inclusion lines) avoid targets that intersect the edges of the 
image (see Figure 35). To adjust the size of the frame, move the mouse while 
holding down the <Ctrl> key.

Figure 35:  The sampling frame should be adjusted to include as many profiles as possible. 
However, make sure that the inclusion lines (broken lines) do not touch targets that also 
touch the edge of the image.
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3. Press the left mouse button to sample the image. MCID Basic scans the sampling 
frame (and the region adjacent to the inclusion lines) for targets that fall within 
the segmentation range and gathers data from them. To be included in the sample, 
a target profile must:

i)satisfy the detection criteria (i.e., fall within the established density 
segmentation range),

ii)fall within the boundaries of the sampling frame, or
iii)touch an inclusion line

On the image, sampled target profiles are outlined in red. 
4. Repeat the sampling procedure for the remaining images in the series. Later, we’ll 

use the auto-sampling feature to sample an entire image set in one operation.

Reporting Data

Data are reported in the data table as each image is sampled. Each line in the table represents 
data from a single sample. Note that MCID Basic automatically uses the image filenames as 
Section labels. Each column in the data table represents a measure that was selected at the 
start of the tutorial. Data are defined as follows, in units that reflect the image calibrations.

Ns Number of target profiles sampled
As Area sampled (µm2)
Na Number of target profiles per µm2

Vv Ratio of target volume to sample volume
Aa Ratio of target intercepts to total intercepts
Sv Mean surface area per µm3

Vm Mean target volume (µm3)
NOTE: Since the images are calibrated in microns, Na is very small. The value of Na 

would be much larger (106 times greater) if it was expressed per mm2 (i.e., if the 
images were calibrated in millimeters instead of microns). However, Vm would 
then be very small.

Data are also displayed in graphical form. The graph area displays the incremental 
calculation of any single measure in the data table, plotted against the parameter that is used 
to calculate it. Sv, for example, is plotted as a function of the number of test probes used in 
its calculation. It is a useful way to monitor the reliability of particular measures as sampling 
progresses. To select the measure to plot in the graph area, click on its column heading in the 
data table.

Editing the Data

Automated target detection rarely works as perfectly as it does with these specially 
constructed sample images. Inclusion and exclusion errors are bound to occur with real tissue 
specimens, no matter how carefully you define the target detection criteria. Some post-
sampling editing of data is usually necessary to overcome deficiencies in the automated 
target detection process.
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MCID Basic provides two ways to edit stereological measures. One way is to add or delete 
targets in the sampled image(s). The other way is to edit the stereological probes upon which 
particular measures (i.e., Sv, Vm) are based.

TO ADD OR DELETE TARGETS IN A SAMPLED IMAGE:
1. Open the Edit menu and select the Stereo editing tool option (or press <F8>).
2. Select Scan windows editing as the editing mode (Figure 36).
3. The Stereo Sample toolbox becomes the Scan Editing toolbox, which contains 

tools for adding or deleting targets. Select the Delete tool:

Figure 36: MCID Basic provides two editing modes for stereological data. Select “Scan 
windows editing” to add or delete targets in sampled images. Select “Stereology editing” to 
edit the probes upon which a measure is based.

4. Move the cursor over the image. The arrow becomes an inverted “V”. Click the 
cursor on any sampled (i.e., red) target profile and the target fill color disappears. 
Data that correspond to the sample are updated in the data table. Delete a few 
more profiles.

5. Remaining tools are used to add targets to the sample. These tools operate just 
like sample tools. Select one of the Autoscan tools and use it to add one of the 
targets you deleted in Step 4. To add it, click on background, then click on the 
target profile. Note again that the data table is automatically updated each time a 
target is added to the sample.

6. Click [Done] to exit Scan windows editing.
TO EDIT SPECIFIC STEREOLOGICAL PROBES:
1. First select the measure you wish to edit by clicking on its column heading in the 

data table. Click on the Sv column heading. On the images, MCID Basic displays 
the probes and intersection points that were used to derive the Sv measure.

2. Open the Edit menu and select the Stereo editing tool option (or press <F8>).
3. Select Stereology editing as the editing mode (Figure 36).
4. Select the Surface probe tool from the Stereo Editing tool box:

5. The Surface probe tool is used to edit the mean surface density measure (Sv), by 
adding or deleting intersections between test probes and target profile boundaries. 
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On the sampled images, intersections are shown as small green circles 
(Figure 37).

6. To delete an intersection point, click on it with the right mouse button. Click the 
left mouse button to add a new intersection point. Data are updated accordingly as 
each probe is edited.

7. Click [Done] to exit editing mode, or press <F8>.

Figure 37: A sampled image showing the probes and intersection points used to estimate the 
mean surface density measure (Sv).

Compiling Data

The Table toolbar provides two summary tables for displaying stereological data:

Data is currently displayed in the Target table, which contains data from each individual 
sample. In order to generate measures that are representative of the entire specimen, we must 
pool data obtained from individual samples (i.e., across all sections).

TO COMPILE DATA ACROSS ALL SECTIONS:
1. Display the Table toolbar if it isn’t visible (View > Table bar).
2. Select the Stereology table from the drop-down list.

MCID Basic computes and displays the appropriate summary value (mean, total) for all 
measures. The table also summarizes the appropriate stereological parameters upon which 
the measure is based (e.g., # frames, # intercepts).
The data can be printed, saved to disk, or exported to other programs in text or spreadsheet 
format.
Before proceeding to the next tutorial section, please return to the “Target table” and 
press the [Clear] button.
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Procedure: 3D Disectors
This section describes the procedures used to derive 3D Disector measures. Unlike 2D 
Frames and 3D Probes measures, 3D Disector measures are derived from serially adjacent 
sections, separated by a known distance and perfectly registered (aligned) with each other.

Displaying the Tutorial Images

TO LOAD IMAGES:
1. Press <Shift+F5> to clear all of the displayed images. Press <Shift+F4> to clear 

all overlays.
2. Open the Image menu and select Image set > Retrieve.
3. When the Retrieve Image Set dialog box appears (see Figure 29), navigate to the 

directory where the sample images are stored (the default directory is \MCID 
Basic 7.0\IMG) and retrieve the images DS01.IM - DS16.IM. Retrieve the images 
into a Storage list with their calibrations.

4. Click [OK] to proceed.
5. A small Retrieve Image File dialog box appears on the screen (Figure 38). Press 

the [Current] button to display the first image file (DS01.IM) in the current 
channel. Use the [Previous] and [Next] buttons to navigate through the image set 
as required.

Figure 38: The image storage list is used to load an image set into the current channel, one 
file at a time.

Selecting Measures 

TO SELECT MEASURES:
1. Open the Sample menu and select Measures selection. The Measures Selection 

dialog box appears on the screen (see Figure 31).
2. Press the [Clear] button to remove the previous 2D Frames and 3D Probes 

measures from the list of Selected Measures.
3. Open the Stereo: 3D Disector group of measures and add every measure to the 

list of Selected Measures.
4. Click [OK] to proceed. The selected measures (N, Nv, and Vs) appear as separate 

columns in the data table.

Establishing Target Detection Criteria

The segmentation range that was established for the SV1.IM - SV4.IM image set is sufficient 
for the current image set. However, if you wish to establish other detection criteria, Ctrl - 
click on the Scan Area icon to re-display the Scan Area dialog box.
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Gathering Data

These images are also sampled with a “sampling frame”. Data are derived from target 
profiles that fall completely within its boundaries plus any target, which touches the inclusion 
lines. Targets that touch the exclusion lines are not included in the sample.
In this example, however, we will use another kind of sampling frame. Given the size of the 
image set (16 image files), we will also use the MCID Basic “auto-sampling” feature to 
sample the entire set in one operation. Either of these features ensures that the same 2D 
coordinates are sampled in every image.

TO GATHER DATA:
1. Open the Stereo Sample tool box and double-click on the Channel frame tool:

2. When the Stereology Frame Cursor Settings dialog box appears (Figure 47), turn 
on the Auto sampling on sections option.

3. Click [OK] to proceed.

Figure 39: The Frame Cursor Settings dialog box is used enable automatic sampling across 
an entire image set.

4. Select the Channel frame tool and move the cursor to the first image. Again, the 
goal is to size the sampling frame to select as many target profiles as possible, 
while making sure that the broken sides of the frame (inclusion lines) avoid 
targets that intersect the edges of the image (see Figure 33).

5. Unlike the Continuous frame tool, the Channel frame is locked into a fixed 
position within a channel. To adjust the initial size of the frame, move the mouse 
while holding down the <Ctrl> key. To position the frame, move the mouse while 
holding down the <Shift> key.

6. Click the sampling frame in the first image in the series. When the Auto Sampling 
On Sections dialog box appears (Figure 40), select the Image list option.
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Figure 40: The Auto Sampling On Sections dialog box.

7. Click the [Sample] button to begin sampling the image set. MCID Basic 
generates the appropriate test probes (i.e., disectors), scans each image for targets 
that meet the detection criteria, and reports the results in the data table.

8. On the images, target profiles that fall within the segmentation range are filled 
with red overlay. To be counted as a 3D target, a target profile must be absent 
from the preceding section (the “lookup” section). Profiles that are absent from 
the lookup section (i.e., new 3D target tops) are outlined in green.

9. Data are reported in the data table as each image is sampled. Each line in the table 
represents data from a single sample and is designated by the image filename. 
Since the first image in the series has no corresponding “lookup” section, no data 
are displayed for this image.

10. Each column in the data table represents a measure that was selected at the start of 
the tutorial. Data are defined as follows, in units that reflect the image 
calibrations.

N Number of 3D targets contained in the sample
Nv Number of 3D targets per µm3

Vs Volume sampled (µm3)
NOTE: Since the images are calibrated in microns, Nv is very small. The value of 

Nv would be much larger (106 times greater) if it was expressed per mm3 
(i.e., if the images were calibrated in millimeters instead of microns)

11. Data are also displayed in graphical form. To select the measure to plot in the 
graph area, click on its column heading in the data table.

Editing the Data

To overcome deficiencies in the automated target detection process, MCID Basic provides 
two ways to edit 3D Disector measures. One way is to add or delete 2D targets profiles in the 
sampled image(s). The other way is to add or delete 3D target tops.

TO ADD OR DELETE 2D TARGET PROFILES IN A SAMPLED IMAGE:
1. Select the image you wish to edit by highlighting the corresponding line of data in 

the data table.
2. Open the Edit menu and select the Stereo editing tool option (or press <F8>).
3. Select Scan windows editing as the editing mode (see Figure 36).
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4. Select the Delete tool from the Scan Editing toolbox:

5. Move the cursor over the image. The arrow becomes an inverted “V”. Click the 
cursor on any 2D target profile and the target fill color disappears. Data that 
correspond to the sample are updated in the data table where applicable. Delete a 
few more profiles.

6. The remaining tools are used to add targets to the sample. These tools operate just 
like sample tools. Select one of the Autoscan tools and use it to add one of the 
targets you deleted in Step 5. To add it, click on background, then click on the 
target profile. Note again that the data table is automatically updated where 
applicable.

7. 7.Click [Done] to exit Scan windows editing.
TO ADD OR DELETE 3D TARGETS:
1. First select the measure you wish to edit by clicking on its column heading in the 

data table. Click on the N or Nv column heading. Select the image you wish to 
edit by highlighting the corresponding line of data in the data table.

2. Open the Edit menu and select the Stereo editing tool option (or press <F8>).
3. Select Stereology editing as the editing mode (see Figure 36).
4. Select the Profile pointer tool from the Stereo Editing tool box:

On sampled images (other than the first image), 2D target profiles are displayed in 
red. Profiles that were not present in the preceding section (i.e., the tops of new 
3D targets) are outlined in green. To delete a 3D target from the sample, click on 
it with the right mouse button. It then becomes a 2D target profile. To add a 2D 
target profile to the sample, click on it with the left mouse button. Data (N and 
Nv) are updated accordingly.

5. Press [Done] to exit editing mode, or press <F8>.

Compiling Data

Data is currently displayed in the Target table, which contains data from each individual 
sample. In order to generate measures that are representative of the entire specimen, we must 
pool data obtained from individual samples (i.e., across all sections).

TO COMPILE DATA ACROSS ALL SECTIONS:
1. Display the Table toolbar (View > Table bar) if it isn’t visible.

2. Select the Stereology table from the drop-down list.
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MCID Basic computes and displays the appropriate summary value (mean, total) for all 
measures. The data can be printed, saved to disk, or exported to other programs in text, 
Lotus® 1-2-3, or Microsoft® Excel format.
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